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Notes
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EVENT RECEIVER SCENARIO
POWERSHELL EXECUTION
When executing PowerShell commands, you might encounter the following errors.
1.

“Admin SVC must be running in order to create deployment timer job.”

To solve this, go to the Services section in Control Panel / System and Security / Administrative Tools and find the
service called SharePoint Administration. Make sure this service has been started.
2.

“A deployment of retraction is already under way for the solution “Qdabra.DBXL.SharePoint.wsp”,
and only one deployment or retraction at a time is supported”.

To solve this, from the command line, execute the following:
C:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\14\BIN>stsadm -o execadmsvcjobs
If you see the following error: “The administration service is running so all administration jobs will be run in the
timer service”, go to the Services section in Control Panel / System and Security / Administrative Tools and find the
service called SharePoint Administration. Stop the service and then re-execute
C:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\14\BIN>stsadm -o execadmsvcjobs

THE OPERATION HAS TIMED OUT
We have seen the following error (sent via email by the Event Receiver) when the hard drive is low on disk space:
Web url: http://q-dev64-01
Library: ExpenseReport20130819
User: Ernesto Machado (Test) (i:0#.w|autonomysystems\ernestom)
Item ID: 8
Item Url: ExpenseReport20130819/8.xml
Exception:
The operation has timed out
To resolve, ensure the server where SharePoint is installed does not have disk space issues.

IS THE WSP SOLUTION DEPLOYED?
If you need to check whether the WSP has been already deployed, execute the following command in the
PowerShell:
get-spsolution -Identity Qdabra.Dbxl.SharePoint.wsp
To get more details, execute:
get-spsolution -Identity Qdabra.Dbxl.SharePoint.wsp | SELECT *
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UNINSTALLING OR UPDATING THE WSP
To remove the WSP, please execute:
Uninstall-SPSolution Qdabra.Dbxl.SharePoint.wsp
Once this has finished, also execute:
Remove-SPSolution Qdabra.Dbxl.SharePoint.wsp
If you’d like to update the WSP, execute the two commands above, and then redeploy the WSP per the
instructions at the start of this document. Qdabra does not recommend using Upgrade-SPSolution, since it has
some limitations. For details, please see: http://msdn.microsoft.com/en-us/library/aa543659.aspx

OBJECT REFERENCE NOT SET TO AN INSTANCE OF AN OBJECT
When configuring the Event Receiver, you may see a message that says: “Object reference not set to an instance of
an object.” This error typically refers to one of the following errors in the DBXL Url:
•
•

Incorrect server name, e.g. http://<invalid>/qdabrawebservice/
Incorrect service name, e.g. http://<correctservername>/<invalidservicename>/

In SharePoint 2010, the above might also yield the message: “InvalidOperationException” and in SharePoint 2013
“NotSupportedException”.

SECURE STORE SERVICE REQUIRES SHAREPOINT STANDARD OR ENTERPRISE
In the DBXL Settings page, you might receive the following message:
Could not load file or assembly 'Microsoft.Office.SecureStoreService, Version=14.0.0.0, Culture=neutral,
PublicKeyToken=71e9bce111e9429c' or one of its dependencies. The system cannot find the file specified.
The SecureStoreService requires SharePoint Standard or Enterprise. This error might mean you are using
SharePoint Foundation.

DELETING DATA
If you delete an xml document from the Documents tab in the DBXL Admin Tool, that document will NOT be
deleted from the SharePoint Form Library.
However, if you delete the xml document from the SharePoint form library, the data will be deleted from DBXL and
consequently from the SQL database (if a database mapping has been defined).

DBXL TOKENS
When no xpaths are defined for the DBXL tokens in the Settings page, the following will be used by default:
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•
•
•

Name is blank
Author is AUTONOMYSYSTEMS\ernestom
Description is 6ad628ec-19a2-4e27-a0bf-dc15d4d3b325:
1#;ExpenseReport_EventReceiver_20130821/1.xml
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INTEGRATED SCENARIO
INSTALLATION
INSTALL DBXL ON THE SAME SITE AS SHAREPOINT
When using DBXL and SharePoint jointly (Integrated scenario), we recommend installing DBXL on the same site
that hosts the main SharePoint site (typically on port 80). If DBXL and SharePoint reside on separate machines you
will need to select the Web Service option when creating a SharePoint mapping in DAT. You will also need to
configure SSO correctly in order to allow DBXL and SharePoint to communicate. Finally, if you’re going to use IPFS,
having it on a different port creates a “cross-domain” data adapter access which makes configuration more
difficult. Please also verify that the site is running and not stopped.

PAGE NOT FOUND ERROR AFTER INSTALLING DBX L
After installing DBXL, you may see a “Page Not Found” error when accessing the asmx pages. Two possible reasons
for this are:
1.

DBXL was installed on a port other than 80. To fix this, make sure that you have unblocked that port from
the network’s firewall.

2.

The website is configured to use multiple host names and IP addresses. The easiest workaround is to
access your site settings (via the IIS management console) and temporarily remove all hostnames/IP
addresses that will not work. Make sure to leave only the hostname that the currently logged-in user can
access. Uninstall DBXL and reinstall it. After DBXL installs successfully, you can re-add the additional
hostnames and/or IP addresses.

3.

The DBXL installer creates a QdabraWebService folder on the site where it was installed. Please check that
this folder allows Read permission to authenticated users. This is usually granted by DBXL installer
automatically, but in rare cases the person installing DBXL will need to manually add the permission.

ERROR MESSAGE: CLIENT FOUND RESPONSE CONTENT TYPE OF 'TEXT/HTML;
CHARSET=UTF-8', BUT EXPECTED 'TEXT/XML'
When installing DBXL (especially on servers with MOSS 2007) you may get the following error: Error initializing
DBXL database. Client found response content type of 'text/html; charset=utf-8', but expected 'text/xml'. The error
may also show as: “The installation failed, and the rollback was performed. --> An error occurred configuring
system doctypes.” The event viewer, in turn, will show: “Error bootstrapping system doctypes. Call to
BoostrapSystemDocumentTypes at http://<servername>/QdabraWebService/ failed. Encountered a critical error
and needs attention.”
Here are some solutions to try if you encounter this:
A. This error usually relates to local machine accounts not having database administration rights or
membership in the SharePoint permissions groups. Verify that the account you are using to execute the
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installer and the Network Service (or the account you are selecting for DBXL) have administrative
permissions in SQL.
B.

Once SharePoint is installed and the default SharePoint web site (on port 80) is provisioned, the "Default
Web Site" on the machine is locked down. Typically, one would want to install DBXL on the "SharePoint 80" web site. However, the initial configuration panel of the DBXL installer defaults to "Default Web Site".
“Default Web Site” and “SharePoint – 80” are not the same, however -- ensure that "SharePoint - 80" is
selected as the web site for installation.

C.

Ensure that the SharePoint site (from B above) is not stopped in IIS.

DBXL INSTALLATION PRODUCES AN HTTP ERROR 405
During installation, you may encounter an error that reads: “The installation failed, and the rollback had been
performed. Error initializing DBXL database. The request failed with HTTP status 405: Method not allowed.” The
problem arises when ASP.NET has not been registered with IIS, which happens when .NET 2.0 is installed before
IIS. To remedy this problem, run aspnet_regiis.exe -i found in C:\WINDOWS\Microsoft.NET\Framework\(Version)\.

DBXL INSTALLATION PRODUCES AN HTTP ERROR 404
There are four known reasons for an HTTP Error 404 when installing DBXL.
1.

Please check that ASP.NET is enabled in the web service extensions of IIS manager. When setting up the
server where DBXL is going to be installed, there is an option to allow ASP.NET applications under
Windows Components Application Server. This needs to be installed in order for DBXL to install and run
correctly.

2.

Your site may be configured to use multiple hostnames or multiple IP addresses. If DBXL picks the wrong
hostname/IP, the installation could fail. The easiest workaround is to access your site settings (via the IIS
management console) and temporarily remove all hostnames/IP addresses that will not work. Make sure
to leave only the hostname that the currently logged-in user can access. After DBXL installs successfully,
you can re-add the additional hostnames and/or IP addresses.

3.

The HTTP 404 error could be caused by a proxy setting in Internet Explorer. Please disable the proxy to
allow the installation to succeed.

4.

The final possibility involves applications that use ports 80 or 443. The next section covers this scenario.

DBXL WILL ASSUME SSL PORT NUMBER WHEN INSTALLING ON A SITE WITH HTTPS
If you install DBXL on a website configured to use https but later change the configuration to http and reinstall
DBXL, you will receive the error “Could not initialize the database”. When you configure the web site to use https it
stores the port number as 443. Then, when you remove the server certificate from the default website and
reconfigure it to use http, it is not removing the SSL port number from that default website. To prevent this
problem, you will have to remove the port number manually. In inetmgr, open the properties of the web site
which was configured to use https and delete the SSL port number.
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DBXL INSTALLER ENCOUNTERS 503 ERROR
When installing DBXL, you may encounter the following message: “The installation failed, and the rollback has
been performed -->Error initializing DBXL database. --> the request failed with HTTP status 503: Service
unavailable.” Should you come across this:
1) Make sure the App pool is not stopped. If it is stopped, there is likely a problem with the user account and
password combination being used. You can try resetting it in the Identity tab of the app pool’s property
page, then restart the app pool, and then try installation again.
2) Make sure that you installed to the correct site (and not a disabled site).
3) If using SharePoint 2007, make sure the Network Service account is in the WSS_WPG group.

IIS SITE CONFIGURED TO RUN AS 32 BIT MAY NOT WORK WITH DBXL 64 BIT
The Cablib.dll installed with the 64bit installer is for a 64bit environment. But it may be that an IIS site is
configured to run as 32bit and thus fails to load the 64bit cablib.dll. If this is the case, please try installing the 32bit
version of DBXL.

VIRTUAL DIRECTORY NOT CREATED DURING INSTALLATION
During installation, you may encounter the following error: "The specified path
'/LM/W3SVC/769376297/ROOT/QdabraWebService' is unavailable." This causes the installer to stop. A
workaround is to click OK in the error dialog, then go to IIS Administration and create the virtual directory. The
QdabraWebService folder should have been created under the website; right-click on it, select Properties, click
Create and click OK. Then switch back to the installer and complete the installation.

SITE DROPDOWN DEFAULTS TO HTTPS
During installation the site dropdown will default to https on some environment, even if there is no SSL certificate
installed. Change the dropdown to not use https if no certificate is configured; otherwise installation might fail.

NET FRAMEWORK ON 64BIT - CONNECTION CLOSED
The screenshot below shows an installation failure that may show itself due to a bug in the .NET 2.0 Framework on
64bit machines. The Crypto apis cause crashes when null (empty) string/byte arrays are passed into
Convert.FromBase64String (or other Crypto apis). Problems like this may not be easily reproduced, as crashes may
be exhibited differently depending on the machine. Should you encounter a similar issue, please contact us for
assistance.
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REINSTALLATION OF DBXL WILL NOT WORK IF APP POOL IS CHANGED TO INTEGRATED
PIPELINE MODE
During installation of DBXL, the DBXL App Pool is set to Classic .NET App Pool by default. If later you change the
DBXL App Pool to “Integrated” Pipeline mode to support SharePoint workflow, reinstallation of DBXL will not work.

To prevent this problem, you will have to delete the DBXL App Pool. In IIS, open the Application Pool and delete
the DBXL App Pool from the list, and then re-run the installation.

DISABLE LOOPBACK CHECK TO COMPLETE IN STALLATION
On load balanced servers you might encounter an issue installation DBXL; this is an issue encountered for any web
service, not just DBXL. The issue is well described in the following link:
http://blog.crsw.com/2008/10/14/unauthorized-401-1-exception-calling-web-services-in-sharepoint/. Microsoft
Support also discusses the issue here: http://support.microsoft.com/default.aspx?scid=kb;EN-US;896861. To install
DBXL,
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•
•

Add the DisableLoopbackCheck registry entry discussed in this Microsoft KB article. Note: you will
need to reboot your server before the DisableLoopbackCheck takes effect.
Be sure to add your load balanced host name for your web farm to the Hosts file on each front end
web server. Use the loop-back IP address (127.0.0.1). This will ensure that each web server looks at
itself to access the web services preventing any trips back out to the load-balancer – and possibly
calling the web service another web server in the farm. This will be much less efficient.

If this problem appeared to be inconsistent (sometimes erroring, sometime successful), this is most likely due
having multiple web servers. The call to the web service will be successful if by chance the load balance redirected
the call to the same (self) web server to access the web service. It will fail when trying to call across to a different
web server.

DBXL INHERITS MODULES FROM PARENT SITES
When installing DBXL Server edition, you may run into an error that begins with the following text:
Error bootstrapping system doctypes
Client found response content type of 'text/html; charset=utf-8', but expected 'text/xml'.
The request failed with the error message:
Please review the entire error recorded in the Event Viewer; it may mention of <httpModules>. If it does, it is likely
that some SharePoint or web site add-on may not function properly with DBXL’s application pool. These modules
are inherited by the QdabraWebService from parent sites.
This can be easily resolved by specifying it be removed for the QdabraWebService virtual directory. You can edit
the SharePoint web.config, in the parent folder of the QdabraWebService. Add the following section just be
before the </configuration> at the bottom of the web.config file.
<location path="QdabraWebService">
<system.web>
<httpModules>
<remove name="<your_module_name_here" />
</httpModules>
</system.web>
</location>
DBXL inherits the web.config settings, and manual exclusion using the <location> node is the only way to exclude
them without uninstalling them. Of course, the other option would be to uninstall the solution which had originally
added the httpModule.
This could also happen with <httpHandlers>, in which case they can be excluded as show below:
<location path="QdabraWebService">
<system.web>
<httpHandlers>
<clear />
<add path="trace.axd" verb="*" type="System.Web.Handlers.TraceHandler" validate="True"
/>
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<add path="WebResource.axd" verb="GET"
type="System.Web.Handlers.AssemblyResourceLoader"
validate="True" />
</httpHandlers>
</system.web>
</location>

WINDOWS VISTA WITHOUT SP1 - QDABRA WEBDAV ROOT PROTOCOL HANDLER
You may have to install a special WebDAV protocol handler in the root web site to work around a bug in Windows
Vista machines without SP1. This is because Windows Vista always queries the root web site regardless of where
your installation lies.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Open inetmgr.exe and expand the Web site where DBXL is installed.
Right click on the QdabraWebService and select Open.
Open the bin folder.
Copy the Qdabra.Dbxl.WebDAV.dll from this folder.
Return to Internet Information Services, right click on the default Web site and select Open.
Open the bin folder.
Paste the Qdabra.Dbxl.WebDAV.dll into this folder.
Click Start > Run and enter cmd.exe.
Navigate to the bin folder where you copied Qdabra.Dbxl.WebDAV.dll.
Add the dll to the Global Assembly Cache for the local computer by following these steps:
a. Open Control Panel and click on Administrative Tools.
b. Double click Microsoft .NET Framework 2.0 Configuration.
c. Expand My Computer and click on Assembly Cache.
d. Click Add an Assembly to the Assembly Cache in the view.

In the dialog that pops up enter the path to the dll referenced in the above steps and click OK.

SHAREPOINT MAPPING
These notes are only valid for the Integrated scenario.

SHAREPOINT SITE IS N OT BROWSEABLE ON THE SERVER
If the SharePoint site is not browseable on the server where DBXL is installed, you will encounter issues with the
DBXL-SharePoint integration. On some servers, you will not even be able to install DBXL. On some servers, you’ll
encounter a variety of errors when integrating DBXL and SharePoint. To avoid this, we recommend that you check
whether the SharePoint site is browseable on the server. If it is not, please read the following Microsoft KB article
to resolve the issue. http://support.microsoft.com/kb/896861

SANDBOX FORMS WITH CODE AUTHENTICATE WITH DBXL AS A SERVICE ACCOUNT
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If your form uses qRules (SubmitToDbxl) and a SharePoint mapping, the code will authenticate with DBXL as a
service account. This would require granting additional permissions in DBXL in order to avoid an Access Denied
error when the qRules command executes.
To work around this issue, submit using a regular data connection (SubmitDocument) instead of submitting via
qRules.

SHAREPOINT OPERATION S CAN CHANGE THE DBXL APPLICATION POOL
Changing the SharePoint authentication provider may change the DBXL application pool, therefore “breaking”
DBXL and producing the following error.
Server Error in '/QdabraWebService' Application.
Request is not available in this context
Description: An unhandled exception occurred during the execution of the current web request. Please
review the stack trace for more information about the error and where it originated in the code.
Exception Details: System.Web.HttpException: Request is not available in this context
For example, you may change the Authentication Provider for the default zone via Central Admin (Application
Management – Manage Web Applications), from NTLM to Negotiate. Every time you do this, the
QdabraWebService virtual directory changes to use the same application pool as the parent site.

USING THE SEARCH WEB PART WITH SHAREPOINT DESIGNER
If you use SharePoint Designer to modify a page that contains the Search web part, the web part will become
broken and unusable; you will have to delete and recreate it. However, if the web part is initially added via the
SharePoint Designer, it can be edited there.

ENCODING CHANGE FOR PROMOTED PROPERTIES AFFECTS DATA VIEWS
In DBXL v2.4, the encoding of promoted properties was changed. This affects users of SharePoint web parts that
make use of promoted properties that contain spaces. Therefore, all data views using GetMyListItems or
GetListItems that have promoted properties containing spaces will no longer have the _x005F in the name. For
example, ‘Status Code’, which was ‘Status_x005F_x0020_Code’ is now ‘Status_x0020_Code’.

ERRORS ENCOUNTERED WHEN CREATING SHAREPOINT MAPPING
If you plan on using DBXL to create SharePoint mappings, we recommend installing DBXL to use the same account
as the SharePoint App Pool. If DBXL is not using the same account as the SharePoint App Pool, you might get an
error when creating the SharePoint mapping in DAT: “An unhandled exception occurred while calling the
SetDocumentType method. S002: Caught exception ensuring SharePoint form library <URL>. The Web
application at <URL> could not be found. Verify that you have typed the URL correctly. If the URL should be
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serving existing content, the system administrator may need to add a new request URL mapping to the intended
application.”
To fix this, follow these steps:
1.

Open IIS, and select Application pools:

2.
3.
4.

Make a note of the identity being used by the SharePoint App Pool.
Give this identity read and write permissions (db_datareader and db_datawriter) to DBXL databases
(QdabraDBXL and QdabraUtility), and any database doctypes are shredding to.
Select the DBXL app pool, and Advanced Settings:

5.

Under Identity, click the … button:

6.

Select Custom account and click Set:
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7.

Enter username and password (the same user the ShP App Pool runs under) and click OK to close all
dialogs.

After following these steps, try to add your SharePoint mapping once again.

ERRORS ENCOUNTERED WHEN CREATING SHAREPOINT MAPPING FOR A FORM WITH CODE
DBXL allows you to create a SharePoint mapping for your DBXL Document Types. However, if your form has code,
you may encounter errors if you try to use the "Publish Library and XSN" checkbox available in the SharePoint tab.
These errors will cause the form in SharePoint and the form in DBXL to be out of sync, and the same will happen
for documents that you submit. If your solution has code, please follow the steps detailed here and here.

CANNOT WRITE TO EVENT VIEWER
While working in DBXL you may encounter the following error: “Caught exception ensuring SharePoint form
library <URL>. Cannot open log for source 'Datatabase Accelerator'. You may not have write access.” The
problem is that an event is being written while still impersonating the caller. Since the caller does not have
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permission to write events to the Qdabra eventlog, this error is shown. The workaround is to grant rights to
everyone to write events to the Qdabra log. To do this:
1.
2.
3.
4.
5.

Run regedit.exe.
Navigate to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\EventLog\Qdabra
Right-click the Qdabra node.
Select Permissions
Give Authenticated Users full permission (or grant the DBXL Admins group full permission).

This will allow the actual error causing the error to be written to the eventlog and reported back to the user.

UNCHECK THE “PUBLISH LIBRARY AND XSN” CHECKBOX TO IMPROVE DAT PERFORMANCE
The “Publish Library and XSN” checkbox only needs to be checked when you first publish your InfoPath form
template to SharePoint or when your InfoPath form changes. To help performance, uncheck the checkbox until
your form changes. When it does, the form needs to be re-published to SharePoint by checking the “Publish
Library and XSN” and saving the Document Type.

PROMOTED FIELDS NAMED “DESCRIPTION” DO N OT GET DISPLAYED BY SHAREPOINT
If you promote a field in your form as “Description”, the SharePoint form library will not display the column, even
though it seems configured properly in both SharePoint and InfoPath. As a workaround, when you promote that
field, name it something other than “Description”.

ALL MAPPING INFORMATION IS DESTROYED WHEN SHAREPOINT MAPPING IS DELETED
Removing a Document Type’s SharePoint mapping destroys the information about the relationship between the
DBXL document and the SharePoint item. Therefore, once a mapping is deleted from the SharePoint tab in DAT,
you will need to delete and recreate the SharePoint library, and then reshred all your documents.

DOCUMENT IMPORT FAILS FOR DOCUMENT TYPES WITH SHAREPOINT MAPPING
DAT allows you to import xml documents into any Document Type. However, if the target Document Type
possesses a mapping to a SharePoint library, you will encounter timeout errors, even with a small quantity of
documents. Instead, we recommend the following:
1.
2.
3.
4.
5.

Remove SharePoint mapping in DAT.
In SharePoint, delete the library.
Import documents using the Documents tab.
Use Publish XSN checkbox to recreate the library and the mapping.
Reshred all so that documents are remapped into SharePoint.

If you are importing a large quantity of documents (in the order of hundreds), please use our Document Deployer
tool.

DBXL::NAME MUST BE UNIQUE
http://www.qdabra.com
Last updated on 12/30/2013 3:20 PM
Copyright © 2006-2012 Autonomy Systems, LLC. All rights reserved.

Page 15 of 46

Starting in DBXL v2.5, the web service expects the DBXL::Name token to be unique. This value is used as the title in
the SharePoint mapping. If the value of DBXL::Name is blank, the web service will use ({DOCID}), and if there are
duplicates in the DBXL::Name, the web service will append the DOCID to distinguish between them.
Starting in DBXL v2.7, you can add a setting in web.config to modify the way DBXL maps XML forms to SharePoint.
If the key is set to true, the DBXL::Name is ignored and the DocID is used instead. This is not, by default, included in
DBXL’s web.config and must be manually added above the closing appSettings tag.
<add key="UseDocIdForSharePointFileName" value="true" />
<add key="UseDocIdForSharePointFileName-YourDocTypeNameHere" value="true" />

USE A DBXL LINK TO OPEN DOCUMENTS FROM SHAREPOINT
If you have a SharePoint mapping, DBXL adds a linked column to the Form Library where the Document Type is
mapped. The column is called “Name (linked to document with edit menu)”.
The URL used for this column is http://<servername>/<FormLibraryName>/<DBXL::Name>.xml or
http://<servername>/<FormLibraryName>/<DBXL::DocID>.xml (see the release note above). This is the link to the
XML as stored by SharePoint. Using this is REQUIRED if opening the form in the browser.
However, there is a second column added to the Form Library but not added to the default view. This column is
called “Name (linked to document)” and uses the link
http://<servername>/QdabraWebService/Documents/<DocID>/<DBXL::Name>.xml. This is the link to the XML
stored within DBXL.
This is a useful workaround for scenarios where the user is allowed to move or delete the document from
SharePoint. If you open a document using the SharePoint link, SharePoint puts a lock on the document. For
updating, this usually works, because the person updating it is the one who has it locked. But when a conditional
SharePoint mapping causes the document to be moved to a different library, it must be able to delete the
document the user has open. Opening using the DBXL link prevents the lock and allows the deletion of the
document from SharePoint.

DAT DOES NOT VALIDATE CONDITIONAL MAPPING EXPRESSIONS
If you add a conditional mapping in DAT’s SharePoint tab, the expression is not validated by DAT. Please make sure
that you are using a valid expression (xpath, operator and value).

FORM VERSION CONFLICT WHEN PUBLISHING TO SHAREPOINT FROM INFOPATH
When mapping DBXL Document Types to SharePoint, we recommend using the "Publish Library and XSN”
checkbox. There are times when you may need to publish your InfoPath form template directly to SharePoint. In
this situation, care should be taken to ensure synchronization between the form version numbers in DBXL and the
SharePoint Form Library. To maintain this consistency, you must use the form template stored in the SharePoint
Form Library when creating the new Document Type. Simply enter the URL
http://<servername>/<yourformlibrary>/forms/template.xsn when creating the Document Type in DAT.

DOCTYPE DETERMINATION DOES NOT WORK WITH RECEIVE-TYPE DATA CONNECTION S
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DBXL includes two checkboxes, labeled "Publish form and XSN" and "Use Forms Services", in the SharePoint tab in
DAT. These allow you to publish your form template to a SharePoint Form Library and IPFS-enable it. When doing
this, DBXL attempts to automatically determine the DocType name on every submit. This only works for Submittype data connections, and fails for Receive-type data connections.

WORKFLOW WILL NOT START AFTER DOCUMENT UPDATE
When you set up SharePoint workflow and select “Start this workflow when an item is changed”, you might see
that the workflow status is not updated in the SharePoint library’s main page, even if the document has already
been updated from DBXL. You can verify the status by clicking on the document in SharePoint and selecting
“Workflows”. The workflow page will be displayed indicating that the workflow has already been started. For a
solution to this issue, please read this document.

ERRORS ENCOUNTERED WHEN OVERWRITING A DOCUMENT IN SHAREPOINT
When a different user to the one who originally submitted a SharePoint document tries to edit and resubmit it,
errors in the Qdabra eventlog will prevent completion of the SharePoint submit. To workaround this problem, you
must give users read/write permissions to the Qdabra eventlog. Please see the document called How to Give Users
Event Log Permissions to Allow SharePoint Overwrite for details on the solution.

“OPERATION ABORTED” ERROR WHEN CREATING A SHAREPOINT MAPPING
When adding a SharePoint mapping in the DBXL Administration Tool, you may discover that Web Service works,
while Object Model does not. If you want to use browser forms (thus SharePoint and DBXL reside on the same
machine), you’ll need to use Object Model. When you try to save that mapping, however, DAT produces the
following error:

If you encounter this issue please check the Application eventlog for errors matching the time of the Qdabra DBXL
error. You may discover a SharePoint error at those times with Network Service not having permission to access
the SharePoint database. The Object Model option does direct database access. To solve this, please switch DBXL
to use the same identity as the SharePoint app pool.

PERMISSIONS ERROR WITH SHAREPOINT WEB SERVICE MAPPING
When using the Web Service option in the SharePoint mapping tab, you may encounter an error like this:
Error updating list item metadata in SharePoint collection http://dbxl-test3/TestLibrary: 0x81020016 Item
does not exist
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The page you selected contains an item that does not exist. It may have been deleted by another user.
(DocType = 'TestForm', DocId = 7) encountered a critical error and needs attention.
Usually this error is related to a permissions issue and is generated by a user who has limited permissions to DBXL
Document Types or Documents and when Check Out is required in SharePoint. Even after removing the Check Out
requirement, you may still get the following:
Caught exception saving document to SharePoint collection http://dbxl-test3/TestLibrary. (DocType =
'TestForm', DocId = 7) encountered a critical error and needs attention:
System.InvalidOperationException: Cannot open log for source 'Database Accelerator'. You may not have
write access. ---> System.ComponentModel.Win32Exception: Access is denied
To workaround this issue, a registry change is needed on the server where DBXL is installed. Please proceed with
caution. Edit the CustomSD value under
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Eventlog\Qdabra]. Append “(A;;0x3;;;S-1-1-0)” at
the end of the value (without the quotes). The value should end up looking something like this:
"O:BAG:SYD:(D;;0xf0007;;;AN)(D;;0xf0007;;;BG)(A;;0xf0007;;;SY)(A;;0x7;;;BA)(A;;0x7;;;SO)(A;;0x3;;;IU)(A;;0
x3;;;SU)(A;;0x3;;;S-1-5-3)(A;;0x3;;;S-1-1-0)"

IF USING SHAREPOINT MAPPING, USE THE SHAREPOINT IDENTITY FOR THE DBXL APP POOL
If adding a SharePoint mapping to your document type, make sure that the DBXL app pool uses the same account
as the SharePoint application pool. Otherwise, you might encounter errors that say “Invalid URI: The format of the
URI could not be determined” or “The Web application at http://<your_sharepoint_site> could not be found”.

ERROR WHEN ADDING A CONTENT TYPE MAPPING TO A SIGNED FORM WITH CODE
If your InfoPath form template is a signed form with code, and you want to use a content type mapping, you might
encounter an error when saving the document type in DAT.
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The steps to reproduce this error are as follows:
1.
2.
3.
4.
5.
6.
7.
8.

Publish XSN as site content type to a SharePoint library [ShPLibrary1].
Add the content type to ShPLibrary2.
Add the published content type to DBXL using link in ShPLibrary1 [e.g.
http://<servername>/MyContentTypes/InvistaForm.xsn]
Check "Form template is signed".
Go to SharePoint tab in DAT.
Insert mapping to http://<servername>/InvistaTest4/Forms/AllItems.aspx
Click Save.
Click Download button in DAT’s General tab.

Thought it’s not clear why InfoPath shows “Catastrophic failure”, it is not possible to open signed forms from DAT,
so this is not a valid scenario because the publishUrl in the XSN will be different from DBXL's template URL. In place
of the error shown above, it is possible that you obtain a different error (about not being able to open the form
from its location) for the same scenario.

DBXL DOES NOT ADD COLUMNS TO THE DEFAULT VIEW
When you save a SharePoint mapping in DBXL v2.6, the web service will create additional columns (related to the
DBXL web service) but will not add them to the default view. If you wish to add these columns, they can be added
to each view individually, as desired.

RESHREDDING WILL NOW PRESERVE THE MODIFIED COLUMN
In previous versions of DBXL, reshredding would change both the ModifiedBy and Modified columns to show the
user who reshredded and the time of the reshred. Starting in DBXL v2.6, a reshred will preserve the value of the
Modified column (to the last person who modified the XML). However, in order to do so, the person reshredding
must be a site collection admin in SharePoint.

MAPPING FAILS DUE TO WEBDAV ROLE
When setting up a SharePoint mapping you might encounter a 405 error (Method Not Allowed). This SharePoint
mapping error is a result of the WebDAV role being installed on the server. This is a known problem with
SharePoint not functioning with WebDAV installed, described here:
http://sharepointinterface.com/2009/12/28/sharepoint-webdav-and-a-case-of-the-405-status-codes/ The fix is to
uninstall the WebDAV role on the SharePoint web front end server and then save the SharePoint mapping in DBXL.

DBXL PERMISSIONS WHEN SANDBOXING FORMS IN SHAREPOINT 2010
If you’re working on SharePoint 2010 and your InfoPath form has code, DBXL will be using the Sandboxing feature
in SharePoint to publish the form. If using the qRules command SaveToDbxl, you might encounter the following
error:
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Action: SaveToDbxl. Arguments: submit: SubmitDocument
xpath: /my:myFields/my:File
. Details: I0033Access denied. Stack: at Qdabra.Utilities.SubmitDocument(String docType, String name, String
author, String description, SubmitDocument submitDocument, XPathNavigator xml, String& docId, String& refId)
at Qdabra.Tools.RulesLibrary.Commands.SubmitQdFileToDbxl(String submit, String domainId, String&
base64Value, String& fileName, String& fileExtension)
at Qdabra.Tools.RulesLibrary.Commands.SaveToDbxl(String submit, String dsname, String xpath, Boolean
qdimage, String domainid)
at Qdabra.Tools.RulesLibrary.Commands.SaveToDbxl()
at Qdabra.Tools.RulesLibrary.Commands.ExecuteCommand()
In that sample scenario, the workaround is to enforce permission in the QdFile system docytpe so that everyone
(NT AUTHORITY\Authenticated Users) is allowed to Add. This is necessary because, when using sandbox, users
authenticate as the service account, so the service account needs permissions to add QdFiles.

IPFS REQUIRES DBXL AND SHAREPOINT ON THE SAME MACHINE
If you wish to add a SharePoint mapping to your DBXL solution in conjunction with IPFS, such that your forms open
in the browser, you will need to install DBXL on the same machine as SharePoint. When setting up the SharePoint
mapping in DAT, this means using the Object Model. Web Service is not possible for this scenario, because crossmachine UDC connections are not supported. For more information, please see the documents called “How to IPFS
enable a DBXL solution” and “How to set up a SharePoint mapping using Web Service” on InfoPathDev.com >
Downloads > DBXL Documentation > SharePoint Integration. If you wish to use IPFS when DBXL and SharePoint
are on different machines, please refer to the Side-by-side documentation (DBXL v2.4 and newer).

INFOPATH 2010 FORM WITH ON-LOAD SHAREPOINT 2010 DATA CONNECTION
An InfoPath 2010 browser-enabled form with an on-load data connection that retrieves data from a SharePoint
2010 library or list may present an error when using DBXL v2.4 (or newer). This is because InfoPath 2010 uses
relative paths for this data connection. The workaround is to:
1.
2.
3.
4.

publish the XSN template directly from InfoPath to SharePoint,
download the template from SharePoint,
attach the downloaded XSN to DBXL,
and then add the SharePoint mapping, checking “Publish XSN” and “Use Forms Services”.

By publishing the form directly from InfoPath to SharePoint, the data connections get fixed up and can then be
used without issue in DBXL.

IPFS SHAREPOINT SUBMIT FAILS WITH TIMEOUT EVEN WHEN SUCCESSFUL
On a cold server SharePoint submit times out (even though it is successful). This happens because SharePoint can
take longer than 30 seconds to process a new document. As a result, the submit operation succeeds but IPFS
reports to the user that it failed due to timeout.
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The default data connection timeout in the IPFS settings is 10 seconds. If the data connection is taking longer than
10 seconds to connect to DBXL, expect to get an error. Increase this timeout value to resolve the issue. Thanks to
Marcello Brocchi for the solution for this issue.
If this does not solve the issue, please see this document for code that allows you to increase the timeout value.

IF LEFT IDLE, SUBMIT BUTTON IN BROWSER FORM FAILS
In browser (IPFS) forms you might have issues with the submit button if the form is left idle. Please check the
following:
1.
2.

3.

There is a proxy server set in Internet Explorer and the Sharepoint URL was not in the bypass list. Make
sure you bypass the proxy when using QdabraWebService.
Open Sharepoint Central Administration > Application Management > Configure InfoPath Forms Services
and make the following changes:
 Default Data Connection Timeout: 60000
 Maximum data connection timeout: 60000
 Number of postbasks per form session state: 200
 Number of Actions per postback: 400
 Maximum size of form session state: 4096
 Select the location to use the storing form session state: Set this radio button to "form view”
Open the Infopath form in design mode and click on Tools > Form Options > Browser. Deselect the option
to "Refresh the form before submitting it if form data might change during processing".

HOST HEADERS CREATE SHAREPOINT-RELATED ERRORS
DBXL v2.4 allows you to query data from SharePoint and create mappings that link DBXL and a SharePoint Form
Library. If the URLs used to access the SharePoint and DBXL sites are different, you will encounter crossdomain/machine issues. As an example, let's assume the SharePoint site is http://portal/ and DBXL is installed on
http://machine01/QdabraWebService/. If portal is just an alias for machine01, you can either
Option A: Reinstall DBXL
1.

2.
3.
4.

5.
6.

Go to the directory where DBXL is installed and create a copy of DBXL’s web.config file.

Why do we back this up? If you have any settings right now, such as database aliases, you’ll use
this as a reference to restore those values later.
Uninstall DBXL. This can be done via Control Panel.
Add portal as a hostheader entry on the SharePoint site.
Reinstall DBXL.
 As you install DBXL, the installer should pick up the portal hostheader and web.config should use
http://portal/qdabrawebservice/ (instead of the IP).
From DAT, click Edit and then click Save for every document type.

This will propagate the change to all document types.
Make any necessary updates to the new web.config that was created by the installer.

Option B: Fix up the web.config manually
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1.
2.
3.
4.

5.

Go to the directory where DBXL is installed. Open the web.config file in a text editor.
Update the DBXL web.config to use http://portal/qdabrawebservice/... instead of http://<ip
address>/qdabrawebservice/. You can find and replace all instances.
Reset IIS.
Execute PublishDATFormTemplate. This is done by opening http://portal/qdabrawebservice/ in Internet
Explorer from the same machine where DBXL is installed. Click on “Admin service” and then click on
PublishDATFormTemplate. You’ll enter the full path to the location of DAT-template.xsn (the path may be
C:\Inetpub\wwwroot\Qdabrawebservice\install\DATtemplate.xsn, but please verify). Then click the
button.
Click Edit and then click Save for every document type.
 This will propagate the change to all document types.

DAT DOES NOT DETECT WHETHER BROWSER FORMS ARE SUPPORTED
The DBXL Administration Tool (DAT) does not detect whether the SharePoint server supports browser forms.
When a user checks “Use Forms Services” and browser forms are not supported by the server, the error returned
might be confusing, as seen below:

This simply means that the server does not support browser forms.

SHAREPOINT 2010 AND TRUSTED ROOT CERTIFI CATES
SharePoint 2010 requires adding trusted root certificates in SharePoint Central Admin before SSL connections can
be established in IPFS forms. If you encounter problems with data connections in browser-enabled (IPFS) forms
on, please verify whether these certificates have been added.

COMPATABILITY WITH WSS 2.0
Though DBXL is compatible with WSS 2.0, there are certain limitations:


“Publish Library and XSN”: On the SharePoint tab in DAT, there is a checkbox labeled “Publish Library and
XSN.” This allows DBXL to create a SharePoint Form Library based on the template.xsn saved in DBXL, but
it is not compatible with WSS 2.0. For users with WSS 2.0 there is a workaround, detailed in the document
called How to Create SharePoint Mappings on WSS 2.0.
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QuerySharePoint: If you are using WSS 2.0, users may encounter an error when calling the
QuerySharePoint web service. The problem occurs because WSS 2.0 will not accept the human readable
name as column name. To workaround this problem, use the static name column as value for the
following parameters: tns:valueColumn, tns:displayColumn, tns:sortColumn and tns:sortOrder. Remember
to also modify your queries (in tns:query and tns:filterXml parameters) to use the static column name. To
get information about the static column name, navigate to
http://<servername>/QdabraWebService/QuerySharePoint.asmx, and choose the DescribeListSchema
method. You can then enter a SharePoint list name in order to retrieve all columns’ static name values.
Propagate deletes: The document called How to propagate deletes from SharePoint to DBXL explains how
to allow SharePoint and DBXL to keep delete operations in sync. However, this is not compatible with WSS
2.0.
If using DBXL v2.4 with WSS 2.0, DBXL must be installed on the same machine as SharePoint. Otherwise,
DBXL will not be able to create SharePoint mappings.

INSTALLATION FAILS DUE TO SQL CONNECT ION REFUSED
If the DBXL install fails because the SQL connection was refused, it could be that the SQL Server is too busy to
handle the connection. The installer attempts to determine if SharePoint is installed, which can result in the
SharePoint site being started if it isn’t already running. Depending on your system resources, the startup of
SharePoint may prevent SQL Server from having resources to handle additional connections. The workaround is to
ensure that the SharePoint site has been pre-loaded on the system before continuing the installation. The steps
are as follows:
1.

Start the DBXL installer and proceed to the setup dialog with the tabbed pages.

2.

Using Internet Explorer, navigate the homepage of the website that DBXL is being installed.

3.

If the site shows an ‘Cannot complete this action’ error, wait a minute and click the ‘Go back to site’ link
(or re-enter the SharePoint home page url). Repeat until the home page displays correctly.

4.

Once the page displays correct, proceeded to finish the DBXL install.

MOVING THE DATABASES USED BY DBXL
1.

2.

Move of QdabraDBXL and QdabraUtility databases (where database name IS NOT changed)
a. Update the web.config to point to the new database server
b. Grant the DBXL account access to the QdabraDBXL and QdabraUtility databases.
i. If using Network Service, it will be DOMAIN\DBXLSERVERNAME$
ii. If using Domain account, use domain\useralias
c. If Shredding databases are moved to same server as QdabraDBXL/QdabraUtility:
i. If using Network Service, it will be DOMAIN\DBXLSERVERNAME$
ii. If using Domain account, use domain\useralias
d. Update mapping for each doctype to change Data Source of the shredding data connection.
Move of QdabraDBXL and QdabraSamples databases (where database name IS changed) IMPORTANT:
There are QdabraDBXL database references in the QdabraUtility database. The only way to fix these is to
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3.

reinstall DBXL using existing databases. Since the installer script does not drop and recreate, we will need
to update DBXL scripts to drop first and recreate.
a. Uninstall DBXL
b. Restore databases to new server
c. Install DBXL using existing databases
d. Update mapping for each doctype to change Data Source of the shredding data connection.
e. Grant reader/writer access to shredding databases for DBXL service account
i. If using Network Service, it will be DOMAIN\DBXLSERVERNAME$
ii. If using Domain account, use domain\useralias
Moving DBXL front end
a. Move databases per steps in #1
b. Reinstall DBXL on new server, pointing to existing databases.
c. All doctypes will need to be resaved to fixup the xsn references. To do this simply click Edit then
Save for each Document Type.

SUBMIT WEB SERVICE MAY PROD UCE A TIMEOUT ERROR
When a Document Type has complex Database/SharePoint mappings, the user may see a timeout, even though
the document is correctly submitted to DBXL and to the configured mappings. You may also encounter an error
when retrieving a large dataset using QueryDB. This happens because InfoPath has a default of 30 seconds for web
service timeouts. A workaround involves using form code to extend the timeout and thus prevent the client-side
error.

SHAREPOINT LISTENER NOT REMOVED AFTER DELETING MAPPING
If you add a SharePoint mapping with a delete listener, the listener does not get removed if you simply delete the
SharePoint mapping and save the document type.
Instead, uncheck Delete listener, save the document type and then remove the SharePoint mapping.

SHAREPOINT LISTENER ISSUE WITH DOCUMENT LOCKING
If a user locks a DBXL document (for example, via a call to LockDocument), then tries to delete the document from
SharePoint, the document is deleted from SharePoint but not from DBXL. However, if a different user has the
document locked, the second user will get a message explaining the lock from the other user. Since the user that
locked the document is the same user who is trying to delete, one would not expect an error message.
Though not a common scenario, Qdabra is investigating a fix for a future version of DBXL. As a workaround for
users on DBXL v2.8 or earlier, Qdabra recommends forcing users to release the lock on the document before
allowing the delete.
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UPGRADING AND MIGRATION
UPGRADING
UPGRADING OVERWRITES STORED PROCEDURES ON QDABRAUTILITY
If you have created any custom stored procedures on QdabraUtility, upgrading DBXL to v2.7 or v2.8 will overwrite
these custom changes, e.g. QdSendEmail. Before performing an upgrade, backup your existing databases, so that
you may restore the modified stored procedures once the upgrade has been completed.

OFFICE 2013 AND FULL TRUST FORMS
Customers who choose to upgrade to Office 2013 must reinstall full trust forms after the upgrade. Examples of
these full trust forms include the DBXL Standalone Dashboard, QueryBuilder and ReportBuilder.
To reinstall these full trust forms, you can use Qdabra’s FormsInstaller. The instructions for installing QueryBuilder
apply for other Qdabra forms.
ReportBuilder is available here.
The DBXL Standalone Dashboard is available on the machine where DBXL was installed, in this path: C:\Program
Files (x86)\Qdabra Software\Qdabra DBXL Standalone Edition

SHAREPOINT MAPPINGS AFTER UPGRADING DBXL
This applies to users that have an existing SharePoint mapping (Integrated scenario) with a previous version of
DBXL. SharePoint mapping has been updated to use the DBXL::Name token at the Title in SharePoint. If no
DBXL::Name token is declared, then DBXL will use the DocID. In addition, DBXL will promote some additional
columns. After upgrading DBXL, verify that open and submit works for existing documents without issues, then
perform a Reshred All to update to the new promoted columns.

INFOPATH RETAINS PREVIOUSLY CACHED DAT AFTER UPGRADING DBXL
After upgrading DBXL, InfoPath could retain the cached version of the Administration Tool (DAT). To fix this, there
are three cache locations we must clear. First, clear the InfoPath cache by running Infopath /cache clearall from a
command line prompt. Second, run: rmdir /s /q
C:\Users\<username>\AppData\Local\Microsoft\InfoPath\FormCache2 (which is the path for InfoPath's cache
folder and it may vary depending on your machine and OS). Finally, clear your cache in Internet Explorer.

MIGRATION
IMPORTING DOCUMENTS WITH THEIR REFIDS INTACT
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The ImportDocuments method allows the user to import documents with their RefID intact. To do this, a data
connection to the service must be manually created, with the importExistingRefId parameter set to "true". The
Document Type's "XPath to inject RefId to" field must be filled out with an appropriate XPath. Note that once the
RefID XPath has been established, changing it will break previously submitted documents.

MIGRATION TOOL COULD FAIL TO IMPORT LARGE LOCAL FOLDERS
If you have over 100,000 documents you wish to import into a DBXL Document Type, the Migration Tool may fail
to read the directory and import the files. If you encounter this issue, break up the import folder into smaller
batches.
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GENERAL NOTES
The following notes do not apply to a specific scenario.

INSTALLATION
DBXL CAN ONLY BE INSTALLED ON MACHINES T HAT ARE PART OF A DOMAIN
Database Accelerator (DBXL) can only be installed on machines that are part of a domain. In order to verify that
your machine is part of a domain, go to Start, right click My Computer and choose Properties. Select the
Computer Name tab and click Change. Verify that your machine is part of a domain. Workgroups will not work.
You may still choose to install DBXL on a non-domain machine but, as a result, parts of DBXL that deal with
authentication (such as the Active Directory web service) will fail to work.

ISSUES WITH APPLICATIONS THAT USE PORTS 80 OR 443
Here is a scenario that could take place with DBXL: You obtain an error that says: “Unable to start debugging on
the web server. The server committed a protocol violation. Section=ResponseStatusLine”. Then you discover (in the
IIS Management Console) that the web site is not running. When you try to start, you get the error: “Unexpected
Error 0x8ffe2740 Occurred”.
This issue is not exclusive to DBXL. It is happens because some applications (e.g. Skype) use common
communication ports (e.g. 80 for http or 443 for https) can conflict with Internet Information Server. If the
application is installed prior to IIS, then IIS will not have access to these ports. This can cause a 404 error when
trying to access a web page hosted on the local server and may also generate errors when starting a website.
One remedy is to uninstall the application and verify that IIS is serving pages properly. The application can be
reinstalled and will choose a different port if IIS is already using the common ports. However, note that some
applications, like Skype, allow you to choose different ports to remedy this situation without removing the
application.

IIS 32 BIT MODE ON A 64 BIT MACHINE
While installing DBXL, the following error might be recorded in the Event Viewer:
Failure registering DBXL with .NET v2.0.
Exitcode: 1
C:\Windows\Microsoft.NET\Framework64\v2.0.50727\aspnet_regiis.exe -sn
"w3svc/862185221/Root/QdabraWebService" encountered a critical error and needs attention.
The installer should also stop and show the following dialog:
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While the install error is still up, execute the aspnet_regiis -sn command:
> C:\Windows\Microsoft.NET\Framework64\v2.0.50727\aspnet_regiis.exe –sn
"w3svc/862185221/Root/QdabraWebService"
You might see text similar to the following:
Start registering ASP.NET scriptmap (2.0.50727) at w3svc/862185221/Root/QdabraWebService. Error
when validating the IIS path (w3svc/862185221/Root/QdabraWebService). Error code = 0x80040154

This error indicates that IIS is in 32 bit mode, though trying to run a 64 bit application. To solve this, refer to
http://technet.microsoft.com/en-us/library/aa996091(v=exchg.80).aspx. This article will ask you to execute:
cscript c:\inetpub\adminscripts\adsutil.vbs SET /w3svc/AppPools/Enable32BitAppOnWin64 False
After running the cscript command, an an iisreset, the DBXL installation should be successful.

DAT WILL NOT OPEN BECAUSE OF KERBEROS
When launching the DBXL Administration Tool you could get infinitely prompted, meaning that the login
credentials are not being recognized. If your users encounter this issue, please check the following:
1.
2.
3.

Open a command prompt,
Change to the folder c:\inetpub\adminscripts\
Run the following command

Cscript adsutil.vbs get w3svc/{WEBSITEID}/root/QdabraWebService/NTAuthenticationProviders
If the authentication method displayed is "Negotiate", then this tells us that Kerberos is enabled. If Kerberos is
enabled on the site, you can do one of the following:
a.
b.

Change the DBXL app pool in IIS to use the same identity as the SharePoint app pool .
Disable Kerberos on the QdabraWebServiceFolder
 Cd C:\inetpub\adminscripts\
 cscript adsutil.vbs set w3svc/3/root/QdabraWebService/NTAuthenticationProviders "NTLM"

You should recycle the DBXL app pool after either of these two options.
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SQL DATABASES
DATABASE NAMES CANNOT CONTAIN SPACES
Installation of DBXL will fail and produce an error message when the database name entered contains a space. By
default, the database names are QdabraDBXL and QdabraSamples. You may change these, but you must use a
database names that do not contain spaces, periods or square brackets.

SQL FULL TEXT SEARCH
In some SQL 2008 installations, the full text search option may not be checked by default. In order for all of DBXL’s
search capabilities to work, you will need to make sure that the full text search option in SQL is installed.
Otherwise, DBXL installation will continue, but DBXL will not have access to full text search.

SQL SETUP PRODUCES A RED FLAG ON ENVIRONMENT CHECK
On IIS 7, users may find running a web setup MSI on a Windows Vista machine may not generate any useful error
messages. To remedy this, uninstall SQL and then make sure that all the IIS features are turned on. Then you can
reinstall SQL, making sure that there are no red flags on environment check.

SQL CONNECTION ERROR CONCERNING THE SHARED MEMORY PROVIDER
During installation of DBXL you might encounter an error that reads: The installation failed, and the rollback has
been performed. Error initializing DBXL database. Cannot initialize database 'QdabraDBXL' on server
'<servername>'. See eventlog for details. In Event Viewer, the details of this error read: Shared Memory Provider,
error: 0 - No process is on the other end of the pipe. The workaround requires disabling the shared memory
protocol for SQL Server using the configuration tool. Note that this error should only take place when SQL server
and DBXL are on the same machine.

SQL DEFAULT DATABASE NOT SET
After restarting SQL Server and/or IIS, you might encounter an error that reads "Shared Memory Provider, error: 0 No process is on the other end of the pipe". Log into SQL Server under another admin login and check the
properties stored for the usual login account. If you find that the default database is not set, reset the default
database and then log in under the usual login account.

BEST PRACTICE FOR DATABASE REDUNDANCY WITH DBXL
Large enterprises generally have redundancy mechanisms in place for critical SQL databases and are managed by
an IT staff. For those without the large IT staff to manage your systems, you may still need something more than
nightly backups. For high-availability without high cost, SQL Server 2005 Standard and Enterprise Edition
introduced database mirroring support. Using a passive SQL Server to mirror the DBXL database, you can obtain
high-availability without the need for an additional SQL Server license. The SQL instance can be on an existing or
new server (including VMs) with sufficient resources to host the database. Just remember when using VMs, that
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failovers should reside on different physical hosts. For additional information, refer to SQL Server 2005 Books
Online topic “Overview of Database Mirroring”.
SQL Server 2005 Workgroup does not support database mirroring but does support transaction log shipping, which
is similar to asynchronous database mirroring. For additional information, refer to SQL Server 2005 Books Online
topic “Understanding Log Shipping”.
Additional licensing information can be obtained here.

“CANNOT GENERATE SSPI CONTEXT”
When working with DBXL, SQL is required. Some organizations deal with multiple SQL instances and this can create
a problem if some SQL instances are on different domains. When we attempt to connect an SQL instance using SQL
Server Management Studio, we might encounter an error that reads: ‘Cannot generate SSPI context’. Here’s a
workaround if you find yourself in a similar situation:
1.

Launch command prompt (cmd).

2.

Use “runas” to launch SQL Server Management Studio. Specifying the userdomain\useralias of the
account user.

3.

For SQL Server 2008 Management Studio, the command will be similar to this:
runas /netonly /user:userdomain\useralias "C:\Program Files\Microsoft SQL
Server\100\Tools\Binn\VSShell\Common7\IDE\Ssms.exe"

For Microsoft SQL Server Management Studio 2005, you’ll use this:
runas /netonly /user:userdomain\useralias "C:\Program Files\Microsoft SQL
Server\90\Tools\Binn\VSShell\Common7\IDE\Ssms.exe"
This should work on Vista, Windows 7 and Windows Server 2008, but has not been tested with 2003 or XP.

CHANGING THE DBXL DATABASE CONNECTION STRING AFTER INSTALLATION
If you change the ConnectionString in DBXL’s web.config file such that it references a different database after
installation, you must invoke InitializeDatabase to update the database schema. You can call the method by using
Internet Explorer to navigate to http://<servername>/QdabraWebService/DbxlAdmin.asmx, click InitializeDatabase
and click Invoke.

PERMISSIONS
USING NON-DEFAULT VALUES FOR PERMISSIONS PREVENTS DAT INSTALLATION
During installation of DBXL you may receive the error "Error publishing Admin Tool: Access Denied". This could be
the result of using non-default values in the Permissions tab during installation. To complete installation, publish
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DAT manually. Log in to the server where DBXL was installed and navigate to the default.asmx page. Click on the
DBXLAdmin web service and then invoke the "PublishDATFormTemplate" web method.

USERS MUST HAVE READ PERMISSIONS FOR THE DOCUMENT TYPE
The QueryDocuments web method requires Document Type Level Read permissions. If a user only has DocumentLevel Read permissions, the QueryDocuments web method will return the error “Access Denied”. This limitation
will be addressed in a future version of DBXL.

CHANGING DOCUMENT LE VEL PERMISSIONS REQUIRES RESHREDDING
If you add or change Document Level permissions for a configuration in DAT, the new permissions schema will not
be enforced for documents that were created previous to the change. Please reshred documents to update
existing documents.

ADD PERMISSIONS TO THE QDABRAWEBSERVICE FOLDER
Typically it is sufficient to add admin users to the DbxlAdminAlias and the AdminGroupAlias as specified in the
web.config file. This grants admin permissions to the members of those groups. However, if you find that your
users need additional permissions to access the DBXL web service, we recommend adding permissions to the
QdabraWebService folder instead of adding the users to the WSS_WPG group.

DBXL ADMINISTRATION TOOL (DAT)
ISSUES OPENING DAT WHEN USING INFOPATH 2010
If you encounter issues when opening DAT, especially when using InfoPath 2010, please try the following steps:
1.

2.

In the default page (http://<servername>/QdabraWebService) right click on the link to open the DBXL
Administration Tool (DAT) and copy the URL. Then paste the URL directly into the address bar in Internet
Explorer and hit Enter.
Close all Internet Explorer and InfoPath instances, and then clear the machine’s InfoPath cache. Then try
to open DAT again.

INFOPATH 2010 FAILS TO UPDATE DAT DUE TO CACHING ISSUE
If you are using Database Accelerator (DBXL) with InfoPath 2010, you might encounter an issue when opening the
DBXL Administration tool (DAT).
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This appears to be a caching issue in InfoPath 2010, due to the fact that InfoPath 2010 doesn’t automatically
attempt to get an update for the form. This only happens if you had a previous version of DBXL installed. The
workaround is relatively simple:
1.

2.
3.

Close all InfoPath instances, and verify that the InfoPath process is not running.
a.
Right click on the task bar and select Start Task Manager.
b.
Click on the Processes tabs and click on the Image name header to sort the processes.
c.
Look for InfoPath.exe.
d.
If it exists, select it and click End Process.
Open InfoPath.
In the File tab select New. You will see the DBXL Admin Tool listed under Qdabra Tools.

Note: If you don’t see DAT in the list of available forms, open Internet Explorer and go to the DBXL page:
http://<servername>/qdabrawebservice, and then click on the DBXL Administration Tool link. The error dialog
might still appear; close it. When you re-open InfoPath, you should now see DAT in the list.
4.
5.
6.

Right-click on the form and select ‘Get update of this form’.
Close InfoPath filler.
Try to launch DAT again.

DAT will update and InfoPath should no longer display errors whenever you click on the link in the DBXL page or
open from your available InfoPath forms.

DAT OPENS BUT NO DOCUMENT TYPES ARE SHOWN
With Windows 7, Vista and Windows Server 2008, UAC (User Account Control) is in effect by default. You must run
IE as an Administrator, or create a security group and add yourself and then change the web.config to use that
group instead of BUILTIN\Administrators. Here are the steps for both options:




Open DAT in Internet Explorer as Administrator:
1.

Right click on Internet Explorer, and select Run as administrator.

2.

Enter url: http://<servername>/QdabraWebService/default.htm

3.

Click the link for the DBXL Administration Tool.

Create a DBXLAdmins group and use it in place of the BUILTIN\Administrators group:
1.

Go to Start > Administrative Tools > Computer Management.
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2.

Expand Local Users and Groups.

3.

Right click Groups, and then select New Group.

4.

Enter “DBXLAdmin” into the field Group name.

5.

Click Add, and enter your alias, Built-in Administrator, and others (if needed). Use Check Names as
you add each one. Then click OK.

6.

Click Create.

7.

Close all InfoPath instances.

8.

Open DBXL’s web.config file (i.e. \inetpub\wwwroot\QdabraWebService\web.config) as
administrator.

9.

Change the line <add key="DbxlAdminAlias" value="BUILTIN\Administrators" /> to <add
key="DbxlAdminAlias" value="machinename\DBXLAdmin" />.

10. Save and close web.config.

DAT WILL NOT OPEN DIRECTLY VIA HTTPS
After installing DBXL, the default web page should load in Internet Explorer. If you click on the DAT link and do not
see an Open button in the dialog, please click Save and store the XSN on your desktop. You will be able open DAT
from your desktop by double-clicking the saved file. This scenario should only happen when using HTTPS.

DO NOT INCLUDE SPECIAL CHARACTERS IN DOCUMENT TYPE NAME
If the name of your Document Type contains special characters (for example: !@#$%^&*) you will experience
problems opening it. To workaround this limitation, please use a Document Type name that does not include
special characters.

CANNOT REMOVE DOCUMENT TYPES THAT CONTAIN RESOURCES
After using the DbxlResource web service to create a new xml resource, you will receive an error if you attempt to
delete the Document Type Configuration for which you have created the Resource. Before deleting such a
Document Type, you must first delete the resource itself using the DeleteResource operation in DbxlResource.

CHANGING PROMOTED PROPERTIES IN A FORM DOES NOT AFFECT EXISTING DOCUMENTS
Promoting properties in a form changes its xml contents. If the promoted properties were changed in a form
template that was already published to DBXL, previously submitted documents will not automatically contain the
xml changes, thus causing issues to some features that depend on promoted properties (i.e. Search Web Part,
SharePoint mappings, etc.). Reshredding the documents in DBXL will update the promoted properties for the
previously submitted documents.
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ENABLE HISTORY IN DAT
Starting in DBXL v2.4, DAT has been modified to have Enable History checked and disabled for new document
types:

This is designed for standalone and side-by-side to automatically detect form versions. The checkbox becomes
editable again in DBXL v2.7. If the checkbox shows as read only and you wish to disable this, please follow these
steps to uncheck it.

ADMIN-DEPLOYED, FULL TRUST TEMPLATES REQUIRE ADDITIONAL PERMISSIONS
In some scenarios, you may have a full trust, admin-deployed content type, in use by DBXL. In this scenario, the
DBXL app pool account needs additional permissions to allow integration with SharePoint using the Object Model
method.




SharePoint Site: Minimum Read Permission
Sharepoint Server: Add to WSS_ADMIN_WPG group
Database:
o Sharepoint Content DB (Site collection database) - db_owner permission
o Sharepoint Config DB (Config DB of sharepoint installation) - db_owner permission

PUBLISH DAT MANUALLY
A situation may arise that will require you to setup DAT manually. For example:
o
o

You change the hostname used to access the website.
If you are using Windows Vista or Windows Server 2008, User Account Control may prevent the user from
being seen as an Administrator and DAT will not be automatically configured during installation. To
complete installation, publish DAT manually, as explained below. (The alternative is to perform a clean
installation, making sure that setup is Run as Administrator.)
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o

During installation of DBXL you receive the error "Error publishing Admin Tool: Access Denied". This could
be the result of using non-default values in the Permissions tab during installation. To complete
installation, publish DAT manually, as explained below. The alternative is to perform a clean installation,
making sure to keep the default values in the Security tab during setup.

To setup DAT manually, follow these steps:
1.
2.
3.
4.
5.

Log in to the server where DBXL is installed.
Open the following URL in IE: http://<servername>/QdabraWebService/DbxlAdmin.asmx (If on Windows
Vista or Windows Server 2008, run Internet Explorer as Administrator.)
Click on the PublishDATFormTemplate method.
Enter the path of the DAT-Template form, which is saved to the local drive. In a non-SharePoint default
installation, the path will be C:\Inetpub\wwwroot\QdabraWebService\install\DAT-template.xsn.
Call PublishDATFormTemplate method by clicking on Invoke button.

If you have already created Document Types, you must execute two additional steps after calling
PublishDATFormTemplate.
6.
7.

Open DAT.
Click Edit and Save for all your Document Types.

RENAMING A DOCUMENT TYPE
Currently there isn't a way to change a document type's actual name via the DBXL Admin Tool’s UI. It would
typically be inadvisable to do so. A document type's Friendly Name, on the other hand, is designed to be
changeable and in cases such as QdFlow e-mail notifications, it is the Friendly Name that matters. The steps to
manually change the Friendly Name are:
1.
2.
3.

Export the Document Type configuration using the DBXL Migration Tool.
Modify the exported XML to change the FriendlyName field value. This can be done in a text editor such
as Notepad.
Re-import the configuration.

INDEXING FEATURES ON THE GENERAL TAB IN DAT
The General tab in DAT contains two features that allow DBXL to index its documents.

The XPath index is for use with the QueryDocuments() method and this has been available in versions previous to
DBXL v2.7.

In DBXL v2.7, a new checkbox is intended to specifically speed up data connections that call
QueryDocumentNodeSets(). Note that enabling XML indexes increases the space occupied in the database, but
improves performance, especially for large XML documents.
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DATABASE MAPPING
DBXL DOES NOT SUPPORT THE WINDOWS INTERNAL DATABASE
The “Windows Internal Database” is a stripped down version of SQL used on standalone WSS 3.0 installs. This is an
embedded data service that can only be used by a handful of Windows Services. You are not allowed to connect to
and use this particular database service. Because Microsoft does not support connecting to that database, you will
need to install a separate instance of SQL in order to install DBXL.

GETDOCUMENTSUMMARYBY TYPE IS LIMITED BY SQL TO 2100 ITEMS
The web service GetDocumentSummaryByType will produce an error if the document type being queried contains
more than 2100 items. This is a SQL limitation. If you need to perform this query, we suggest using the QueryDB
web service.

SHREDDING WITHOUT A KEY RETURNS ERROR IN DATABASE MAPPING
Mapping a form to a SQL database requires the existence of either a key column or an identity column. If the table
does not have an identity column, and the user does not designate a column as the “key” column in the Database
tab, DAT will return a validation error to the user.

ERROR MESSAGE: CANNOT OPEN DATABASE REQUESTED BY THE LOGIN. THE LOGIN
FAILED.
When saving a Database mapping, the following error might arise:

“Connection failed. Error message: Cannot open database <database-name> requested by the login. The
login failed. Login failed for user <username>”
When facing this error, please check whether the database exists, whether your connection string is correct and
whether the username in the error message has permissions to the database.

CANNOT MAP TO A DATABASE COLUMN THAT HAS IDENTITY SET TO ‘YES’
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When you map the DBXL DocID (DBXL::DocID) to a column in your database, make sure the column does not have
Identity setting of ‘Yes’. SQL tries to automatically set the value of identity columns, thus preventing the DBXL Web
Service from setting it. This scenario leads to an error, and therefore you should never map a value into an identity
column in the database.

DBXL DOES NOT SUPPORT 'YES' AND 'NO' AS BOOLEAN VALUES
When shredding Boolean values into a database, DBXL does not support 'yes' and 'no' as Boolean values. When
shredding into ‘bit’ types in the database, the DBXL mapping should be ‘Boolean’ and the XML being submitted
should set the field to either ‘1’, ‘true’, ‘0’ or ‘false’.

CANNOT DELETE DOCUMENTS WHEN THERE IS A MAPPING ERROR
If a Document Type contains mapping errors, deleting a document in that Document Type will fail. Deleting the
Document Type itself will also fail, because DAT attempts to delete all documents before deleting the Document
Type. Remove the connection string in the Database tab, and then delete all documents. You will also need to
manually clean up any databases where the data was previously mapped.

RESHRED ALL FAILS DUE TO TIMEOUT IN DAT
When working with large database mapping or a large number of xml documents, you might encounter a timeout
if you attempt to Reshred All in DAT. To workaround this issue, please download our Document Deployer (also
known as the Migration Tool) to Reshred all documents in the background.

QUERYSHAREPOINT
QUERYING FOR A SPECIFIC VIEW
Using QuerySharePoint, we can query a specific SharePoint view.
The viewName parameter, however, refers to a view GUID, and not the view’s name.

PROVIDING OTHER ARGUMENTS SHOULD OVERRIDE THE VIEW VALUES
There is a bug in some of the QuerySharePoint methods. Providing other arguments should typically override the
view value (viewName). However, as of DBXL v2.8, this is not the case for GetDropdownEntries and
GetDropdownEntriesSiteAndGuid.
For GetListItemsStr and GetListItemsStrSiteAndGuid, the correct behavior is see. That is, when the provides both a
viewName and a <query>, the (filtered) view is ignored, all items are returned and sorted according to the
<query>.
These methods will be reviewed in a future version of DBXL to achieve consistent behavior.
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QUERYSHAREPOINT FAILS ON SHAREPOINT 2003
If you are using SharePoint 2003 (WSS 2.0), users may encounter an error when calling the QuerySharePoint web
service. The problem is due to the fact that SharePoint 2003 will not accept the human readable name as column
name.
To workaround this problem, use the static name column as value for the following parameters: tns:valueColumn,
tns:displayColumn, tns:sortColumn and tns:sortOrder. Remember to also modify your queries (in tns:query and
tns:filterXml parameters) to use the static column name.
To get information about the static column name, navigate to http://<server
name>/QdabraWebService/QuerySharePoint.asmx, and choose the DescribeListSchema method. You can then
enter a SharePoint list name in order to retrieve all columns’ static name values.

USING DYNAMIC QUERIE S IN REPEATING TABLES
If you are using QuerySharePoint in a repeating table, you might encounter a problem with dynamic queries set in
a repeating field. The query (as generated by Query Builder) will not get updated when inserting new rows. To fix
this error, replace the value in the concat query that shows <value>", RepeatingField, " </value> with a current()
parameter.
For example: concat("<query><columns><column name='Product_x0020_Code'/></columns><filter><eq><column
name='Product_x0020_Name'/><value>", current(), "</value></eq></filter></query>")
If you experience the same with QueryDB, use the solution as recommended above.

USE CDATA WHEN WORKING WITH SPECIAL CHARACTERS
When using dynamic query in QuerySharePoint, data with special XML characters (& and <) will get rejected in the
query and will return empty values in repeating tables. To avoid this problem, just add a CDATA tag in your concat
query (the rule that sets the dynamic query for your QuerySharePoint connection). For example:
concat("<query><columns><column name='Product_x0020_Code'/></columns><filter><eq><column
name='Product_x0020_Name'/><value><![CDATA[", current(), "]]></value></eq></filter></query>")
Make sure the value inside the CDATA sequence uses the current() parameter in order to get the correct value in
the repeating field that runs the query. If the same error occurs with QueryDB, use the same solution as
recommended.

QUERYBUILDER
QUERY BUILDER USES THE LOCAL USER’S CREDENTIALS TO CONNECT TO SQL
QueryBuilder uses the person’s local credentials to connect to SQL. Even if you enter a connection string with a
username and password, while working within QueryBuilder, the local credentials are used. The workaround is to
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add database permissions for the user, even if temporarily, while designing the query in QueryBuilder. Once the
query is designed, the user can be removed from the database permissions.

QDABRA’S QUERY BUILDER TOOL USES THE 2007 OM
Qdabra’s Query Builder tool uses the 2007 InfoPath Object Model (OM). Therefore, it is not backwards compatible
with InfoPath 2003. It is forward compatible with InfoPath 2010.

UNINSTALLING QDABRA'S QUERY BUILDER INFOPATH FORM TOOL
Qdabra's Query Builder InfoPath form tool needs to run with full trust so that it can execute shell commands. To
install this full trust tool on your local computer, we use InfoPath’s built-in support for URN based solutions. When
the form is installed, InfoPath adds entries to your Windows registry. Unfortunately, due to a bug in InfoPath
installer, sometimes uninstalling doesn’t work and the registry entries are not cleaned up correctly. Please see this
document for help.

QUERYBUILDER DOES NOT SHOW USER-FRIENDLY COLUMN NAMES
When using older versions of QueryBuilder to build SharePoint queries, the form might display column names that
are not user-friendly, as in the screenshot below.

The <query> generated by QueryBuilder will still work, in spite of the column names. Please upgrade to the latest
version of QueryBuilder to avoid this issue.

INVALID XML
When working with QuerySharePoint or QueryDB, you might encounter an error that says: “Data at the root level
is invalid. Line 1, position 1”. This error indicates a problem with the <query> node. You could try using
QueryBuilder to re-generate the value for <query>.
For example, in a dynamic query, you should check that the <query> that begins with concat() is used in rules and
not in the data connection wizard.
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ENCODED SPACES IN THE URL PRODUCE AN ERROR
When using QueryBuilder and QuerySharePoint, you need to enter the URL to your SharePoint list. Internet
Explorer encodes spaces as %20, but DBXL produces an error if you use a URL containing a %20.
The workaround is simply to replace %20 in the URL with an actual space. This works in QueryBuilder as well as in
the InfoPath data connection wizard.

QUERYDB
USER ENCOUNTERS “DAT ABASE NOT REGISTERED FOR USE" ERROR WHEN CALLING
QUERYDB
Before you can begin using the QueryDB web service, the database being queried needs to be added to DBXL’s
web.config file. Specifically, an entry of the syntax <database alias="DB_Alias" name="SampleDB" server="default"
/> must be added to the configuration/qdabra.dbxl/enumdb/databases node. The SQL server declared during
installation (where the databases QdabraDBXL and QdabraSamples are located) is added by default, but any
additional databases must be added individually.

QUERYDB USES THE CREDENTIALS OF THE WEB SERVICE INSTEAD OF THOSE OF THE
QUERYING USER
QueryDB currently only uses permissions that are defined on the SQL Server that it is querying. Because the
QueryDB web service acts as a liaison between the end user and the database, the database only receives requests
from the web service. This means that any user accessing the web service has the same permissions as the user
account (generally NETWORK SERVICE) that the web service is running as. Since most users have less permissions
as the NETWORK SERVICE account, this is considered an Elevation of Privilege security hole. One way to reduce the
risk is to create a new account for the web service to run as, and only allow that account access to query the DB.
Qdabra will address this issue in a future release.

USING QUERYDB WITH A DYNAMIC SQL TABLE
If your SQL table has the potential to change (for instance, adding a new column), you should have QueryDB access
a SQL view instead of directly accessing the table. This will allow the underlying table to change and small
modifications to the view will prevent your InfoPath solution from breaking.

HOW CAN USERS QUERY NON-DBO TABLES USING QUERYDB?
When calling the QueryDB web service, you’ll get an error message when querying non-DBO tables, such as certain
AdventureWorks tables (e.g. HumanResources.Employee). This is a known limitation of the web service which will
be addressed in a future version.
One workaround would be to give each table a separate view.
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Another option is to manually change the table="" attribute to have the value SCHEMANAME.TABLENAME. This
would allow you to query tables in any schema.

INVALID XML
When working with QuerySharePoint or QueryDB, you might encounter an error that says: “Data at the root level
is invalid. Line 1, position 1”. This error indicates a problem with the <query> node. You could try using
QueryBuilder to re-generate the value for <query>.
For example, in a dynamic query, you should check that the <query> that begins with concat() is used in rules and
not in the data connection wizard.

QUERYING THE QDABRADBXL DATABASE
The DBXL database should be accessed via QueryDB using the built-in alias #DBXLDB#. No additional alias is
needed or should be added in web.config.
When the #DBXLDB# alias is used, QueryDB has logic to prevent access to vital columns in the Document and
DocumentHistory tables, unless these are specified by the form designer in the queryxml. The specific columns
that are excluded are: DataExtractedPlaintext, DocumentXml and DocumentIndexedXml.

MISCELLANEOUS
MODIFYTHE DURATION OF DBXL LOCKS
When editing an XML, DBXL locks documents for 30 minutes by default. If you wish to modify this setting, please
edit the DBXL web.config form, and change the DocumentLockDurationInMinutes parameter. Setting this to -1
(negative one) will make it an infinite timeout.

ACTIVE DIRECTORY WEB SERVICE QUERY FAILS ON WINDOWS XP
If you install DBXL to Windows XP and you cannot query the Active Directory Web service (ADUserInfo.asmx) you
will have to manually configure your machine’s ASP.NET account. To verify that this is the problem, navigate to
http://machine/QdabraWebService/ADUserInfo.asmx, click GetMyInfo and Invoke. If you don’t get XML you will
need to follow the configuration steps detailed in this document.

DBXL RETURNS LICENSING/DOMAIN ERROR WHEN SQL IS UNAVAILABLE
If SQL Server Agent is not running for some reason, opening DAT results in this error:
The query cannot be run for the following DataObject: GetMyDomains
InfoPath cannot run the specified query.
The SOAP response indicates that an error occurred on the server:
System.Web.Services.Protocols.SoapException: Server was unable to process request. --->
System.ApplicationException: You have not installed a license to use the ADUserInfo service.
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at Qdabra.Dbxl.WebService.AdUserInfo.GetMyDomains()
--- End of inner exception stack trace --DBXL cannot get licensing information because there's a problem with SQL. Restarting the SQL services usually
solves this issue.

INFOPATH ERRORS ON OLDER OFFICE SERVICE PACKS
You might encounter the error below if you have upgraded .NET but have not installed the latest Office service
packs:
System.Security.SecurityException
Request failed.
at Microsoft.Office.InfoPath.MsxmlNavigator.IsValidNode(MsxmlNode test)
at Microsoft.Office.InfoPath.MsxmlNavigator.MoveToFirstChild()
at MS.Internal.Xml.XPath.XPathChildIterator.MoveNext()
at MS.Internal.Xml.XPath.ChildrenQuery.Advance()
at MS.Internal.Xml.XPath.AttributeQuery.Advance()
at MS.Internal.Xml.XPath.XPathSelectionIterator.MoveNext()
at System.Xml.XPath.XPathNavigator.SelectSingleNode(XPathExpression expression)
at System.Xml.XPath.XPathNavigator.SelectSingleNode(String xpath)
at Qdabra.Tools.RulesLibrary.Commands.ExecuteCommand(Application application, XmlFormHostItem
formHost, XPathNavigator commandsNavigator)
at Qdabra.Tools.RulesLibrary.FormCode.QdabraRules__Command_Changed(Object sender,
XmlEventArgs e)
at Microsoft.Office.InfoPath.Internal.XmlEventHost.GenericProxy(Object genericDelegate,
DataDOMEvent dataDOMEvent, InfoPathEvents type)
at Microsoft.Office.InfoPath.Internal.XmlEventHost.ChangedProxy(DataDOMEvent dataDOMEvent)
at
Microsoft.Office.Interop.InfoPath.SemiTrust._DataDOMEventSink_SinkHelper.OnAfterChange(DataDOMEv
ent pDataDOMEvent)
To solve, this simply install the latest Microsoft Office service packs.

NOTIFICATIONS EMAIL IS DELIVERED INTO THE JUNK E-EMAIL FOLDER
Microsoft Outlook (and other mail programs) may classify notification email as junk. To avoid this, add the sender
to the “safe list” of your mail software. In the case of Microsoft Outlook, follow these steps:
1.
2.

Right-click on the email that was delivered to the Junk e-mail folder.
Choose Junk E-mail, click Add sender to Safe Senders List.

DIGITALLY-SIGNING DOCUMENTS FOR USE IN DBXL
To track documents, DBXL inserts a processing instruction into the XML on submit, which includes a unique DocID.
After initial insertion, the DocID is used to identify the document when it is resaved, deleted, or reshredded. As a
result of this insertion, you cannot digitally sign a document before submitting it for the first time. To workaround
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this, please read the document called How to use Full Trust form templates in DBXL, which includes a tool that
allows for a workaround.

UPLOADING LARGE ATTACHMENTS IN DBXL
When uploading large attachments in DBXL, a time-out error is likely to occur. This error is due to the IIS
maxRequestLength setting in web.config. maxRequestLength is an optional Int32 attribute. It specifies the limit for
the input stream buffering threshold, in KB. This limit can be used to prevent denial of service attacks that are
caused, for example, by users posting large files to the server. The default is 4096KB. If the threshold is exceeded, a
ConfigurationErrorsException error is thrown. To work around this limit, follow the steps in this document.

DOCUMENTS OPEN IN READ-ONLY MODE IN WINDOWS VISTA
If the client machine has Vista installed, DBXL documents open in InfoPath on Read-only mode. This has been a
known issue in Vista. To get around this, you need to setup a Web folder connection from the client to the server
machine where DBXL is installed.
1.
2.
3.
4.
5.
6.
7.
8.

In the Vista client machine, go to Start, right-click Network and select Map Network Drive. Alternatively,
go to Start > Computer, and on the taskbar, click on Map network drive.
On the Map Network Drive dialog, click Connect to a Web site that you can use to store your documents
and pictures.
The Add Network Location wizard will open. Click Next.
Select Choose a custom network location and click Next.
In the Internet or network address field, enter your server url in the format,
http://<servername>/QdabraWebService, and click Next.
When prompted, enter your Username and Password and click OK.
Type a name for your network location, and click Next, then Finish to exit the wizard.
Verify that you can now open DBXL documents in Read/Write mode.

Note that this workaround is session-based. When you log off your machine and log back on, Vista will override
your credentials again. Since you have already setup a Web folder connection to your server, you just have to open
the Web folder and enter your Username and Password once. Vista will then cache your credentials for that
particular session.

PRESERVE MORE ERROR EVENTS IN EVENT VIEWER
To preserve more error events in your event log, open Event Viewer, right click on Qdabra and select Properties.
By default, the Event Viewer log is set to "Overwrite Events As Needed" and to a maximum log size of 2048Kb. You
may change the default settings as desired.

REMOVING CLUTTER FROM THE QDABRA EVENT LOG
To help form developers debug their form mappings, DBXL logs informational messages to the Qdabra Event Log
when a node is not found in the XML. If your form includes optional sections, a node missing from the XML is
common scenario. Therefore, these messages will create unnecessary clutter. To stop these messages from being
logged, set the logShredWarnings value in DBXL’s web.config to false.
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SQL CLUSTERING
DOCUMENT SUBMISSION FAILS DURING A FAILOVER
If a user tries to submit a document to DBXL at the same time that a failover is happening, the submission will fail
with an error such as:
InfoPath cannot submit the form.
An error occurred while the form was being submitted.
The SOAP response indicates that an error occurred on the server:
System.Web.Services.Protocols.SoapException: Server was unable to process request. --->
System.Exception: Exception Code: I9999
Exception Message: An unhandled exception was thrown: Timeout expired. The timeout period elapsed
prior to completion of the operation or the server is not responding.
at Qdabra.Dbxl.DbxlDocumentServiceEx.CheckAndThrowException(StatusInfo info)
at
Qdabra.Dbxl.DbxlDocumentServiceEx.Qdabra.Dbxl.Services.IDbxlDocumentServiceEx.SubmitDocument(St
ring docTypeName, String xml, String name, String author, String description, String allowOverwrite,
Int32& docId, String& refId)
--- End of inner exception stack trace --The workaround is to allow the failover to complete, and then resubmit the document.

RESHRED ALL DURING A FAILOVER
If a Reshred All operation is executing at the same time a failover happens, the user will see an error such as:

Please allow the SQL failover to finish, then re-execute the Reshred All operation.

STANDALONE SCENARIO
INSTALLATION
STOP THE SERVICE BEFORE UN INSTALLING
Before uninstalling the DBXL Client (for example, to reinstall), you should STOP the service. This can be via the
Control Panel > Administrative Tools > Services.
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STANDALONE EDITION INSTALLATION ERRORS D UE TO SERVICE
If you uninstall DBXL Standalone Edition while the Standalone service is running, you'll get a prompt to select
between TRY AGAIN, CONTINUE and EXIT. Please click Continue to finish installation. You can stop the service
manually before uninstalling if you wish to avoid the prompt.
Sometimes the uninstaller is unable to delete the service. In this situation, please run a command line as an
administrator, and then execute: SC DELETE “Qdabra DBXL Standalone Edition”. Once the service has been
deleted, you may need to restart your machine before trying to reinstall DBXL.

INSTALLATION ERROR WHEN NETWORK SERVICE ACCOUNT LACKS PERMISSIONS
When installing DBXL Client on Windows 7, you might run into an installation failure with an error that reads:
"Failure registering DBXL Standalone dashboard. The remote server returned an error: (404) Not Found.
encountered a critical error and needs attention."
In the eventvwr, you might find a sequence of errors concerning the system document types:
Error deploying sample 'QdUser' encountered a critical error and needs attention:
System.Exception: Web method returned error: I0033: Access denied
at Qdabra.Util.SampleDeployer.ParseResponseForErrors(XmlDocument responseDoc)
at Qdabra.Util.SampleDeployer.DeployMapping()
at Qdabra.Util.SampleDeployer.DeployAllSamples()
The stack trace was: at Qdabra.Util.SampleDeployer.ParseResponseForErrors(XmlDocument
responseDoc)
at Qdabra.Util.SampleDeployer.DeployMapping()
at Qdabra.Util.SampleDeployer.DeployAllSamples().
The eventvwr might also have a failure installing the DBXL license:
Error loading trial license
Access denied encountered a critical error and needs attention.
One possible reason for this installation failure is that the Network Service account does not have permission on
the %windir%\TEMP folder. Grant it full control and install should succeed.
Note that some machines will require a restart after granting these permissions.

STANDALONE EDITION CONFIGURATION FILE
The Client version of DBXL does not use a file called web.config for its configuration. Error messages produced by
certain web services, such as QueryDB, may point to web.config. To address the issues, please modify the
configuration file Qdabra.Dbxl.Standalone.exe.config instead of web.config.

STANDALONE DBXL SERVICE ALREADY EXISTS WHEN REINSTALLING
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When reinstalling DBXL on your local (client) machine, you might be informed that the DBXL service already exists.
Should this happen, launch a command line window and execute sc DELETE "Qdabra DBXL Standalone Edition".
Once deleted, you’ll be able to reinstall DBXL on your client machine.

DETERMINE THE DBXL PORT NUMBER
If you need to determine the port number that the DBXL Client was installed on, you can look at the config file
located here:
C:\Program Files\Qdabra Software\Qdabra DBXL Standalone Edition\Qdabra.Dbxl.Standalone.exe.config
Or on 64-bit
C:\Program Files (x86)\Qdabra Software\Qdabra DBXL Standalone Edition\Qdabra.Dbxl.Standalone.exe.config
<services>
<service name="Qdabra.Dbxl.Implementation.DocumentRetrieval.RequestHandlerRouter">
<host>
<baseAddresses>
<add baseAddress="http://localhost:8000/QdabraWebService" />
</baseAddresses>

DASHBOARD
DBXL STANDALONE VERSION REQUIRES SERVICE RESTART FOR CONFIGURATION CHANGES
Unlike the default IIS configuration (for a server version of DBXL), updating the configuration file will not cause the
standalone service to restart. For config changes to take effect, you will need to recycle the "Qdabra DBXL
Standalone Edition" service in the Administrative Tools/Services applet.
You can also open a command-line (as administrator) and execute:
net stop "Qdabra DBXL Standalone Edition"
net start "Qdabra DBXL Standalone Edition"

TEMPORARY FILES AND DISK SPACE WHEN USING THE DASHBOARD
When using the DBXL Standalone Dashboard, please ensure that the drive that contains the temporary folder (for
example C:\Users\[username]\AppData\Local\Temp\) is not low on disk space. This is because InfoPath has a builtin mechanism that utilizes temp files with names of the format mso####.tmp whenever an InfoPath form is in use;
the Dashboard itself does not have any logic that utilizes temp files. Qdabra's investigation so far has revealed this
to be default InfoPath behavior and not exclusive to the DBXL Standalone Dashboard.

AUTOMATIC SYNC FROM THE DASHBOARD ONLY SUPPORTED ON WINDOWS 7
If you want the Standalone Dashboard to sync documents automatically (on a scheduled task), you’ll need to use
Windows 7. Windows XP and Vista are not supported for automatic syncs.
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USING THE DASHBOARD TO SYNC LARGE XML DOCUMENTS
If you are using the Standalone Dashboard to sync large XML documents, the download or upload operations may
fail because of the document size. The configuration of DBXL (client or server edition) must be updated to increase
the maxStringContentLength/maxReceivedMessageSize. The default is set to 10MB.
<binding name="http" maxBufferSize="10485760" maxReceivedMessageSize="10485760">
<readerQuotas maxStringContentLength="10485760" />
<security mode="TransportCredentialOnly">
<transport clientCredentialType="Windows">
<extendedProtectionPolicy policyEnforcement="Never" />
</transport>
</security>
</binding>
<binding name="https">

UPLOAD FAILS WHEN DASHBOARD SWITCHES TO ANOTHER SERVER
If you are using DBXL's standalone dashboard on your local machine, and DBXL is migrated to another server, you
will need to perform a clean reinstallation locally.
1.
2.
3.

Uninstall DBXL locally and delete both the databases (QdabraDBXL and QdabraUtilities).
Migrate your remote (server) DBXL installation.
Install DBXL locally.

Once you do this, your local dashboard will be able to sync correctly with the new DBXL server.

DELETING FROM SHAREPOINT DOES NOT DELETE ON STANDALONE COPY
If you are using the Standalone Dashboard to sync documents from SharePoint, note that documents must be
deleted manually in both the local DBXL and the remote SharePoint.

NO WARNING IN THE DASHBOARD WHEN THE LICENSE LIMIT IS REACHE D
When performing a sync in the Dashboard, the user typically sees a dialog box showing the number of successful
and failed documents. If the DBXL license limit is reached during the sync operation, this dialog box will not show
that message. To verify your license limits, please check the DBXL Admin Tool (DAT).
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